
Quick Start Guide

Layout Pro Field Software



SOFTWARE END USER LICENSE AGREEMENT

IMPORTANT, READ THIS AGREEMENT CAREFUL-
LY.  BY INSTALLING OR USING ALL OR ANY POR-
TION OF THE SOFTWARE, YOU ARE ACCEPTING 
ALL OF THE TERMS AND CONDITIONS OF THIS 
AGREEMENT. YOU AGREE THAT THIS AGREE-
MENT IS ENFORCEABLE LIKE ANY WRITTEN 
AGREEMENT.

IF YOU DO NOT AGREE TO ALL OF THESE TERMS 
AND CONDITIONS, DO NOT USE OR ACCESS THE 
SOFTWARE.  IF YOU HAVE PAID A LICENSE FEE 
FOR USE OF THE SOFTWARE AND DO NOT AGREE 
TO THESE TERMS, YOU MAY RETURN THE SOFT-
WARE (ALONG WITH ANY HARDWARE ON WHICH 
IT WAS EMBEDDED, IF APPLICABLE) FOR A FULL 
REFUND PROVIDED YOU (A) DO NOT USE THE 
SOFTWARE AND (B) RETURN THE SOFTWARE 
WITHIN THIRTY (30) DAYS OF YOUR INITIAL PUR-
CHASE.

IF YOU WISH TO USE THE SOFTWARE AS AN EM-
PLOYEE, CONTRACTOR, OR AGENT OF A CORPO-
RATION, PARTNERSHIP OR SIMILAR ENTITY, 
THEN YOU MUST BE AUTHORIZED TO SIGN FOR 
AND BIND THE ENTITY IN ORDER TO ACCEPT THE 
TERMS OF THIS AGREEMENT. THE LICENSES 
GRANTED UNDER THIS AGREEMENT ARE EX-
PRESSLY CONDITIONED UPON ACCEPTANCE BY 
SUCH AUTHORIZED PERSONNEL.

IF YOU HAVE ENTERED INTO A SEPARATE WRIT-
TEN LICENSE AGREEMENT WITH LICENSOR FOR 
USE OF THE SOFTWARE, THE TERMS AND CONDI-
TIONS OF SUCH OTHER AGREEMENT SHALL PRE-
VAIL OVER ANY CONFLICTING TERMS OR 
CONDITIONS IN THIS AGREEMENT.

This End User License Agreement (“Agreement”) is 
between Trimble Navigation Limited, located at 935 
Stewart Drive, Sunnyvale, CA 94085 and/or its affil-
iates (“Licensor”) and the customer (individual or 
entity) that has downloaded or otherwise procured 
the licensed Software (as defined below) for use as 
an end user (“you”). This Agreement covers any Soft-
ware and supporting technical documentation pro-
vided with the Software (“Documentation”).

1.Definitions

“Effective Date” means the earlier of the date you 
sign an Order Form or the date on which the Software 
is first made available to you.

“Order Form” means any order which is entered into 
by Licensor (or an authorized distributor or reseller of 
Licensor) and you under which you are provided the 
Software. Each Order Form for the Software shall be 
deemed a part of this Agreement. This Agreement is 
binding on you whether or not you executed an Order 
Form with Licensor. Order Forms may not vary the 
terms of this Agreement. Only a written agreement, 
signed by Licensor (not a Licensor distributor or re-
seller) may vary the terms of this Agreement.

“Software” means the Licensor software product(s) 
provided in connection with this Agreement in object 
code form (or as otherwise specified in any related 
Order Form). “Software” shall also include any re-
leases provided to or purchased by you under any 
separate support and maintenance agreement you 
may enter into with Licensor. Unless otherwise not-
ed, the Software and Documentation are referred to 
collectively herein as “Software.”

“Third-Party Software” means any third-party soft-
ware that is provided to you by Licensor under this 
Agreement or under separate terms and conditions.

“Licensor Supplier” means either Licensor or an au-
thorized distributor or reseller of Licensor products or 
services which has entered into an Order Form with 
you.

2.License

2.1.Grant of License. Subject to all of the terms and 
conditions of this Agreement, Licensor grants you a 
non-transferable, non-sublicensable, non-exclusive 
license to use the Software in machine-readable form 
on any computer and operating system for which it 
was intended, but solely (a) for your own internal 
business purposes at the location specified in the ap-
plicable Order Form (the “Site”); (b) in accordance 
with the Documentation; and (c) in accordance with 
any additional license term, subscription term or oth-
er user, seat, computer, field of use or other restric-
tions set forth in the applicable Order Form or 
otherwise specified upon purchase.

2.2.Installation and Copies. Licensor shall make 
available the Software and Documentation by disk, 
other media, or as embedded in a device, or make it 
available for download in electronic form. Licensor 
shall also provide you with electronic passwords or 
other enabling mechanisms if necessary to permit 
the licensed usage of the Software. All licenses shall 
commence, and delivery shall be deemed to occur, as 
of the Effective Date (or, if later, such date on which 
the Software and license keys are first made avail-
able to you). If your Order Form is with a Licensor dis-
tributor or reseller, that distributor or reseller (and 
not Licensor) is solely responsible for delivery to you 
and Licensor has no liability for any failure to deliver. 
If the Software requires license keys to operate as li-
censed to you, Licensor or the applicable Licensor 
Supplier will deliver such license keys to you.

2.3.Software Intended to be Installed on Computers. 
You may copy and install on your computers for use 
only by your employees the number of copies of the 
Software for which you have paid the applicable li-
cense fee.  You may transfer the Software from one 
computer to another computer provided that the 
computer to which the Software is transferred is lo-
cated at the Site and the Software is completely re-
moved and de-installed from the prior computer.  If 
you are permitted to install the Software on a network 
server, and you transfer the Software from the site to 
a new location, you must provide Licensor with writ-
ten notice of the new site prior to such transfer.  You 
may also make a reasonable number of copies of the 
Software for back-up and archival purposes. This 
Section 2.3 does not apply to any software embed-
ded on devices.

2.4.License Restrictions. You shall not (and shall not 
allow any third party to): (a) decompile, disassemble, 
or otherwise reverse engineer the Software or attempt 
to reconstruct or discover any source code, underly-
ing ideas, algorithms, file formats or programming in-
terfaces of the Software by any means whatsoever 
(except and only to the extent that applicable law 
prohibits or restricts reverse engineering restric-
tions); (b) distribute, sell, sublicense, rent, lease, or 
use the Software (or any portion thereof) for time 
sharing, hosting, service provider, or like purposes; 
(c) remove any product identification, proprietary, 
copyright, or other notices contained in the Software; 
(d) modify any part of the Software, create a deriva-
tive work of any part of the Software, or incorporate 
the Software into or with other software, except to the 
extent expressly authorized in writing by Licensor; (e) 
attempt to circumvent or disable the security key 
mechanism that protects the Software against unau-
thorized use (except and only to the extent that ap-



plicable law prohibits or restricts such restrictions); 
or (f) publicly disseminate performance information 
or analysis (including, without limitation, bench-
marks) from any source relating to the Software. If 
the Software has been provided to you as embedded 
in any hardware device, you are not licensed to sep-
arate the Software from the hardware device. If the 
Software has been: (i) provided to you separately 
from a hardware device but is intended to be loaded 
onto a hardware device specified by Licensor (such 
as a firmware update or other Software programs that 
are designed for use on a specific hardware device 
such as surveying software), or (ii) provided to you 
pre- loaded onto a specific hardware device, your li-
cense is limited to use of the Software on the device 
specified by Licensor, and for no other use.

2.5.Evaluation Software.  Subject to the terms and 
conditions of this Agreement and during the term of 
this Agreement, Licensor may, in its discretion, pro-
vide you with pre-release, beta or other software on 
an evaluation basis (“Evaluation Software”).  You 
may use Evaluation Software solely for internal eval-
uation purposes for 30 days from receipt of the Eval-
uation Software (unless otherwise agreed by Licensor 
in writing) (the “Evaluation Period”). Unless you pay 
the applicable license fee for the Software, the Eval-
uation Software may become inoperable and, in any 
event, your right to use the Evaluation Software auto-
matically expires at the end of the Evaluation Period. 
Evaluation Software shall be subject to all restric-
tions on Software set forth in this Agreement. You 
shall treat all Evaluation Software as Confidential In-
formation of Licensor and shall return or destroy any 
copies of Evaluation Software upon expiration of the 
applicable Evaluation Period.  Any and all sugges-
tions, reports, ideas for improvement and other feed-
back of any type you provide regarding the Evaluation 
Software are the sole property of Licensor, and Licen-
sor may use such information in connection with any 
of its products or services without any obligation or 
restriction based on intellectual property rights or 
otherwise.  You acknowledge that all Evaluation Soft-
ware is provided “AS IS” and may not be functional 
on any machine or in any environment.  THE WAR-
RANTIES OF SECTION 6 DO NOT APPLY TO EVAL-
UATION SOFTWARE. LICENSOR AND ITS 
SUPPLIERS DISCLAIM ALL WARRANTIES RELAT-
ING TO THE EVALUATION SOFTWARE, EXPRESS 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE, TITLE OR NON-INFRINGEMENT.

2.6.Internet-Based Services Components.  Licensor 
or its Suppliers or both, may provide internet-based 
services with the Software which are used to transfer 
files between a hardware device, Software and/or 
your personal computer which is used in connection 
with a hardware device provided by Licensor.  Licen-
sor or its Suppliers may change or cancel such ser-
vices at any time.  Your use of the Internet-based 
services will result in your consent to the transmis-
sion of information, with or without a separate notice 
of connection, between Licensor, Licensor’s Suppli-
er’s, or either of their service provider computer sys-
tems over the Internet.

3.Ownership

Notwithstanding anything to the contrary contained 
herein, except for the limited license rights expressly 
provided herein, Licensor and its suppliers have and 
will retain all rights, title and interest (including, 
without limitation, all patent, copyright, trademark, 
trade secret and other intellectual property rights) in 
and to the Software and all copies, modifications and 

derivative works thereof (including any changes 
which incorporate any of your ideas, feedback or sug-
gestions). You acknowledge that you are obtaining 
only a limited license right to the Software and that 
irrespective of any use of the words “purchase”, 
“sale” or like terms hereunder no ownership rights 
are being conveyed to you under this Agreement or 
otherwise.

4.Payment

You shall pay all fees associated with the Software li-
censed and any services purchased hereunder as set 
forth in the applicable Order Form. All payments 
shall be made in U.S. dollars within thirty (30) days 
of your receipt of the applicable invoice, unless oth-
erwise specified in writing by the Licensor Supplier. 
Except as expressly set forth herein, all fees are non-
refundable once paid. You shall be responsible for all 
taxes, withholdings, duties and levies arising from 
the order (excluding taxes based on the net income 
of the Licensor Supplier). Any late payments shall be 
subject to a service charge equal to 1.5% per month 
of the amount due or the maximum amount allowed 
by law, whichever is less. 

5.Term of Agreement

5.1.Term. This Agreement is effective as of the Ef-
fective Date and expires at such time as all license 
and service subscriptions hereunder have expired in 
accordance with their own terms (the “Term”). Either 
party may terminate this Agreement (including all re-
lated Order Forms) if the other party: (a) fails to cure 
any material breach of this Agreement within thirty 
(30) days after written notice of such breach; (b) 
ceases operation without a successor; or (c) seeks 
protection under any bankruptcy, receivership, trust 
deed, creditors arrangement, composition or compa-
rable proceeding, or if any such proceeding is insti-
tuted against such party (and not dismissed within 
sixty (60) days)). If you have entered into a separate 
written agreement with Licensor which governs the 
Software and that agreement is terminated, then this 
Agreement automatically terminates and you shall no 
longer have any right to use the Software. Termina-
tion is not an exclusive remedy and the exercise by 
either party of any remedy under this Agreement will 
be without prejudice to any other remedies it may 
have under this Agreement, by law, or otherwise. For 
clarity, even if you have entered into an Order Form 
with a Licensor distributor or reseller, Licensor is a 
third party beneficiary to that Order Form and has the 
right to terminate this Agreement as set forth in this 
Section 5 (Term of Agreement).

5.2.Termination. Upon any expiration or termination 
of this Agreement, you shall cease any and all use of 
any Software and Evaluation Software and destroy all 
copies thereof and so certify to Licensor in writing. 

5.3.Survival.  Sections 2.4 (License Restrictions), 3 
(Ownership), 4 (Payment), 5 (Term of Agreement), 
6.3 (Disclaimer of Warranties), 9 (Limitation of Rem-
edies and Damages), 10 (Confidential Information), 
11 (Export Compliance) and 12 (General) shall sur-
vive any termination or expiration of this Agreement.

6.Limited Warranty and Disclaimer

6.1.Limited Warranty. Licensor warrants to you that 
for a period of ninety (90) days from the Effective 
Date (the “Warranty Period”) the Software shall oper-
ate in substantial conformity with the Documenta-
tion. Licensor does not warrant that your use of the 
Software will be uninterrupted or error-free or that 
any security mechanisms implemented by the Soft-
ware will not have inherent limitations. Licensor’s 



sole liability (and your exclusive remedy) for any 
breach of this warranty shall be, in Licensor’s sole 
discretion, to use commercially reasonable efforts to 
provide you with an error-correction or work-around 
which corrects the reported non-conformity, or if Li-
censor determines such remedies to be impractica-
ble within a reasonable period of time, to refund the 
license fee paid for the Software.  A Licensor Suppli-
er other than Licensor may fulfill Licensor’s warranty 
obligations hereunder on behalf of Licensor.  Licen-
sor Suppliers shall have no obligation with respect to 
a warranty claim unless notified of such claim within 
the Warranty Period.

Because the Software is inherently complex and may 
not be completely free of nonconformities, defects or 
errors, you are advised to verify your work.  Licensor 
does not warrant that the Software will operate error 
free or uninterrupted, that it will meet your needs or 
expectations, that all nonconformities can or will be 
corrected, or the results obtained through use of the 
Software.

6.2.Exclusions. The above warranty shall not apply: 
(a) if the Software is used with hardware or software 
not specified in the Documentation; (b) if any modi-
fications are made to the Software by you or any third 
party; (c) to defects in the Software due to accident, 
abuse or improper use by you; (d) to Software provid-
ed on a no charge or evaluation basis; (e) to any Third 
Party Software; or (f) to any Software obtained as 
freeware, whether from Licensor, a Licensor Supplier 
or otherwise.

6.3.Disclaimer of Warranties. THIS SECTION 6 IS A 
LIMITED WARRANTY AND, EXCEPT AS EXPRESSLY 
SET FORTH IN THIS SECTION 6, THE SOFTWARE 
AND ALL SERVICES ARE PROVIDED “AS IS.” NEI-
THER LICENSOR NOR ITS SUPPLIERS MAKES 
ANY OTHER WARRANTIES, CONDITIONS OR UN-
DERTAKINGS, EXPRESS OR IMPLIED, STATUTORY 
OR OTHERWISE, INCLUDING BUT NOT LIMITED 
TO WARRANTIES OF TITLE, MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE OR NON-
INFRINGEMENT. YOU MAY HAVE OTHER STATUTO-
RY RIGHTS. HOWEVER, TO THE FULL EXTENT 
PERMITTED BY LAW, THE DURATION OF STATUTO-
RILY REQUIRED WARRANTIES, IF ANY, SHALL BE 
LIMITED TO THE LIMITED WARRANTY PERIOD. 
YOU ASSUME THE ENTIRE RISK AS TO RESULTS 
AND PERFORMANCE OF THE SOFTWARE.

7.Support & Maintenance

Licensor shall provide the support and maintenance 
services, if any, as separately purchased by you and 
specified in the applicable Order Form. All support 
and maintenance shall be provided pursuant to Li-
censor’s standard service terms which are available 
upon request from Licensor. Licensor Suppliers may 
provide additional support services under separate 
written agreement, but Licensor is not responsible for 
any such support unless it is the contracting party.

8.Professional Services.

The Licensor Supplier shall provide the number of 
person-days, if any, of professional consulting ser-
vices (“Professional Services”) purchased in the ap-
plicable Order Form and related Statement of Work. 
If Licensor is providing Professional Services, unless 
agreed in a separate written agreement all Profes-
sional Services shall be provided pursuant to Licen-
sor’s standard service terms which are available upon 
request from Licensor. If your Order Form is with a Li-
censor Supplier other than Licensor, that party (and 

not Licensor) is solely responsible for providing Pro-
fessional Services and Licensor has no liability relat-
ed to such services.

9.Limitation of Remedies and Damages.

9.1.NEITHER LICENSOR NOR LICENSOR’S SUP-
PLIERS SHALL BE LIABLE FOR ANY LOSS OF USE, 
LOST DATA, FAILURE OF SECURITY MECHA-
NISMS, INTERRUPTION OF BUSINESS, OR ANY 
INDIRECT, SPECIAL, INCIDENTAL, OR CONSE-
QUENTIAL DAMAGES OF ANY KIND (INCLUDING 
LOST PROFITS), REGARDLESS OF THE FORM OF 
ACTION, WHETHER IN CONTRACT, TORT (INCLUD-
ING NEGLIGENCE), STRICT LIABILITY OR OTHER-
WISE, EVEN IF INFORMED OF THE POSSIBILITY 
OF SUCH DAMAGES IN ADVANCE.

9.2.NOTWITHSTANDING ANY OTHER PROVISION 
OF THIS AGREEMENT, LICENSOR AND ITS SUP-
PLIERS’ ENTIRE LIABILITY TO YOU UNDER THIS 
AGREEMENT SHALL NOT EXCEED THE AMOUNT 
ACTUALLY PAID BY YOU TO LICENSOR UNDER 
THIS AGREEMENT.

9.3.THE SOFTWARE IS NOT FAULT TOLERANT 
AND IS NOT DESIGNED, MANUFACTURED OR IN-
TENDED FOR USE IN LIFE SUPPORT, MEDICAL, 
EMERGENCY, MISSION CRITICAL OR OTHER 
STRICT LIABILITY OR HAZARDOUS ACTIVITIES 
(“HIGH RISK ACTIVITIES”). LICENSOR SPECIFI-
CALLY DISCLAIMS ANY EXPRESS OR IMPLIED 
WARRANTY OF FITNESS FOR HIGH RISK ACTIVI-
TIES. YOU REPRESENT AND WARRANT THAT YOU 
WILL NOT USE THE SOFTWARE (OR PERMIT IT TO 
BE USED) FOR HIGH RISK ACTIVITIES, AND 
AGREE THAT LICENSOR WILL HAVE NO LIABILITY 
FOR USE OF THE SOFTWARE IN HIGH RISK ACTIV-
ITIES. YOU AGREE TO INDEMNIFY AND HOLD 
HARMLESS LICENSOR FOR ANY DAMAGES, LIA-
BILITIES OR OTHER LOSSES RESULTING FROM 
SUCH USE.

9.4.The parties agree that the limitations specified 
in this Section 9 will survive and apply even if any 
limited remedy specified in this Agreement is found 
to have failed of its essential purpose.

10.Confidential Information.

Any software, documentation or technical informa-
tion provided by Licensor (or its agents) shall be 
deemed “Licensor Confidential Information” without 
any marking or further designation. Except as ex-
pressly authorized herein, you will hold in confidence 
and not use or disclose any Licensor Confidential In-
formation. You acknowledge that disclosure of Licen-
sor Confidential Information would cause substantial 
harm to Licensor that could not be remedied by the 
payment of damages alone and therefore that upon 
any such disclosure by you, Licensor shall be entitled 
to appropriate equitable relief in addition to whatever 
remedies it might have at law.

11.Export Compliance

You acknowledge that the Software may be subject to 
export restrictions by the United States government 
and import restrictions by certain foreign govern-
ments. You shall not, and shall not allow any third 
party to, remove or export from the United States or 
allow the export or re-export of any part of the Soft-
ware or any direct product thereof: (a) into (or to a na-
tional or resident of) any embargoed or terrorist-
supporting country; (b) to anyone on the U.S. Com-
merce Department’s Table of Denial Orders or U.S. 
Treasury Department’s list of Specially Designated 
Nationals; (c) to any country to which such export or 
re-export is restricted or prohibited, or as to which 



the United States government or any agency thereof 
requires an export license or other governmental ap-
proval at the time of export or re-export without first 
obtaining such license or approval; or (d) otherwise 
in violation of any export or import restrictions, laws 
or regulations of any United States or foreign agency 
or authority. You agree to the foregoing and warrant 
that you are not located in, under the control of, or a 
national or resident of any such prohibited country or 
on any such prohibited party list. The Software is fur-
ther restricted from being used for the design or de-
velopment of nuclear, chemical, or biological 
weapons or missile technology, or for terrorist activi-
ty, without the prior permission of the United States 
government.

12.General.

12.1.Assignment. This Agreement will bind and in-
ure to the benefit of each party’s permitted succes-
sors and assigns. Licensor may assign this 
Agreement to any affiliate or in connection with a 
merger, reorganization, acquisition or other transfer 
of all or substantially all of Licensor’s assets or voting 
securities. You may not assign or transfer this Agree-
ment, in whole or in part, without Licensor’s written 
consent. Any attempt to transfer or assign this Agree-
ment without such written consent will be null and 
void.

12.2.Severability. If any provision of this Agreement 
shall be adjudged by any court of competent jurisdic-
tion to be unenforceable or invalid, that provision 
shall be limited to the minimum extent necessary so 
that this Agreement shall otherwise remain in effect.

12.3.Governing Law; Jurisdiction and Venue.

• 12.3.1.Unless you obtained this Software in 
Canada or the European Union, this Agreement 
is governed by the laws of the State of California 
and the United States without regard to con-
flicts of laws provisions thereof, and without re-
gard to the United Nations Convention on the 
International Sale of Goods.  In such case the 
jurisdiction and venue for actions related to the 
subject matter hereof are the State of California 
and United States federal courts located in San-
ta Clara County, California, and both parties 
hereby submit to the personal jurisdiction of 
such courts.

• 12.3.2.If you obtained this Software in Canada, 
this Agreement is governed by the laws of the 
Province of Ontario, Canada, excluding its rules 
governing conflicts of laws and without regard to 
the United Nations Convention on the Interna-
tional Sale of Goods.  In such case jurisdiction 
and venue for actions related to the subject mat-
ter hereof are the courts of the Judicial District 
of York, Province of Ontario and both parties 
hereby submit to the personal jurisdiction of 
such courts.

• 12.3.3.If you obtained this Software in the Eu-
ropean Union, this Agreement is governed by 
the laws of The Netherlands, excluding its rules 
governing conflicts of laws and without regard to 
the United Nations Convention on the Interna-
tional Sale of Goods. In such case each jurisdic-
tion and venue for actions related to the subject 
matter hereof are the courts of The Hague, The 
Netherlands and both parties hereby submit to 
the personal jurisdiction of such courts.

12.4.Attorneys’ Fees and Costs. The prevailing party 
in any action to enforce this Agreement will be enti-

tled to recover its attorneys’ fees and costs in con-
nection with such action.

12.5.Notices and Reports. Any notice or report here-
under shall be in writing. If to Licensor, such notice 
or report shall be sent to Licensor at the address 
above to the attention of “Legal Department”. If to 
you, such notice or report shall be sent to the address 
you provided upon placing your order. Notices and re-
ports shall be deemed given: (a) upon receipt if by 
personal delivery; (b) upon receipt if sent by certified 
or registered U.S. mail (return receipt requested); or 
(c) one day after it is sent if by next day delivery by a 
major commercial delivery service.

12.6.Amendments; Waivers. No supplement, modifi-
cation, or amendment of this Agreement shall be 
binding, unless executed in writing by a duly autho-
rized representative of each party to this Agreement. 
No waiver will be implied from conduct or failure to 
enforce or exercise rights under this Agreement, nor 
will any waiver be effective unless in a writing signed 
by a duly authorized representative on behalf of the 
party claimed to have waived.

12.7.Entire Agreement. This Agreement is the com-
plete and exclusive statement of the mutual under-
standing of the parties and supersedes and cancels 
all previous written and oral agreements and commu-
nications relating to the subject matter of this Agree-
ment. No provision of any purchase order or in any 
other business form employed by you will supersede 
the terms and conditions of this Agreement, and any 
such document issued by a party hereto relating to 
this Agreement shall be for administrative purposes 
only and shall have no legal effect. Notwithstanding 
the foregoing, if you have entered into a separate 
written license agreement signed by Licensor for use 
of the Software, the terms and conditions of such 
other agreement shall prevail over any conflicting 
terms or conditions in this Agreement.

12.8.Independent Contractors. The parties to this 
Agreement are independent contractors. There is no 
relationship of partnership, joint venture, employ-
ment, franchise or agency created hereby between 
the parties. Neither party will have the power to bind 
the other or incur obligations on the other party’s be-
half without the other party’s prior written consent.

12.9.Force Majeure. Neither party shall be liable to 
the other for any delay or failure to perform any obli-
gation under this Agreement (except for a failure to 
pay fees) if the delay or failure is due to unforeseen 
events, which occur after the signing of this Agree-
ment and which are beyond the reasonable control of 
the parties, such as strikes, blockade, war, terrorism, 
riots, natural disasters, refusal of license by the gov-
ernment or other governmental agencies, in so far as 
such an event prevents or delays the affected party 
from fulfilling its obligations and such party is not 
able to prevent or remove the force majeure at rea-
sonable cost.

12.10.Government End-Users. The Software is com-
mercial computer software.  If the user or licensee of 
the Software is an agency, department, or other enti-
ty of the United States Government, the use, dupli-
cation, reproduction, release, modification, 
disclosure, or transfer of the Software, or any related 
documentation of any kind, including technical data 
and manuals, is restricted by a license agreement or 
by the terms of this Agreement in accordance with 
Federal Acquisition Regulation 12.212 for civilian 



purposes and Defense Federal Acquisition Regula-
tion Supplement 227.7202 for military purposes. 
The Software was developed fully at private expense. 
All other use is prohibited.

12.11.Third-Party Software. If designated in the 
Documentation, the Software may contain or be pro-
vided with certain Third-Party Software (including 
software which may be made available to you in 
source code form). Such Third-Party Software is not 
licensed hereunder and is licensed pursuant to the 
terms and conditions (“Third-Party License”) indi-
cated in the Documentation and/or on the Third-Par-
ty Software.  Except as may be set forth in the Third-
Party License, neither Licensor nor Licensor Suppli-
ers offer any warranty in connection with any Third-
Party Software and neither Licensor nor Licensor 
Suppliers shall be liable to you for such Third-Party 
Software.

If an executed agreement exists between you and Li-
censor at any time regarding the Software, the terms 
of that agreement shall supersede the terms of this 
Agreement in its entirety.  Thus, if you enter into a 
separate written agreement with Licensor regarding 
the Software, that agreement (not this one) will con-
trol your use of the Software; and further if that 
agreement is terminated, you will not have the right 
to use the Software under the terms of this Agree-
ment after termination.  Notwithstanding the forego-
ing, pre-printed terms and conditions on your Order 
form shall not supersede this Agreement.

Trimble Navigation Limited d/b/a Spectra Precision

10355 Westmoor Drive

Westminster, Colorado 80021

Data Collector Warranty Program 

Spectra Precision would like to make you aware of 
the warranty program. A new data collector that has 
been purchased and is still under the one year factory 
warranty or under an extended warranty will be au-
thorized for software updates. Data collectors that 
are not currently under a warranty plan are eligible to 
purchase an extended warranty. There are Layout Pro 
software only warranties that will authorize the data 
collector for software updates, and there are warran-
ties that cover both the data collector hardware and 
Layout Pro software. The extended warranties are a 
good way to protect your investment in your equip-
ment.

The Layout Pro installation program will use your In-
ternet connection to compare the data collector's se-
rial number against a data base that contains the 
warranty status on all units. If the unit is under a val-
id warranty, the installation will proceed. If the unit 
is not covered under warranty, then a message will be 
displayed informing you of this and the installation 
will stop.

To receive Layout Pro minor improvement releases, 
identified by the version numbering system, you only 
need to be on the current version of the latest minor 
update. In other words, if you have version 5.0.x you 
are authorized for a version 5.0.5 improvement re-
lease automatically. For minor updates, 5.0 to 5.1 
for example, it is now required that the data collector 
or Layout Pro software be on a current warranty plan.

The warranty plans are listed on Spectra Precision 
price lists. Data collector serial numbers are required 
in order to generate the proper registration codes for 
your unit and to log the warranty plan into the data-
base.
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Getting Started

Double-tap the Layout Pro icon on the data collector ([1]) or 
total station ([2]) desktop.
With a data collector, the main menu ([3]) will appear 
instantly.
With the onboard version, you will first have to level the total 
station and enter a few parameters (atmospheric, instrument 
parameters) before the main menu ([4]) displays.

Note: In this guide, all screenshots showing a blue title bar originate 
from the onboard version of Layout Pro (i.e. running on the 
instrument used). All screenshots with black title bar are taken from 
a data collector connected to a total station.

[1] [3]

[2] [4]
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Working With Jobs

Starting a New Job 1. Tap Jobs on the main menu. This opens the Jobs menu.

2. Tap Create New Job.
3. Using the keypad, key in a name for the job. The default 

name is the current date. Change it as you prefer.
If you are using a data collector:

– Tap  to show the keypad

– Tap  to hide it.

4. Tap ok at the bottom of the screen.
5. Tap OK to continue.
2



Settings and Preferences

From the main menu, tap Settings. The Settings & Preferences 
window allows you to set:
• The instrument used ([1]) (with a data collector) or some 

instrument-related parameters (atmospheric parameters, 
calibration, DR target settings) with an onboard version.

• The distance units used ([2])
• The format used to display values of distances, angles, 

etc. ([3])
• The layout tolerance and automatic point selection ([4])

Simply tap on the next tab to view the next page of options. 
Tap ok to close the Settings & Preferences window.

[1] [2]

[3] [4]
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Entering a Plan from a Blueprint

Entering a
Basic Plan

1. From the main menu, tap Plan.
2. Tap Input Plan to begin entering your plan.

The following table shows the tools on the right side of the 
window that help you work with the display plan.

3. Enter or select a line start point.
4. Enter the length of the new segment.
5. Set the direction that the line is to be placed. To do this:

– Use the rotate buttons   to rotate it by a 
specified angle.

– Select an angle from the drop-down list.
– Manually enter the angle.

6. Multiple segments of the same length and in the same 
direction can automatically be generated. To do this, key 
in the number of segments in the Repeat field.

The  and  icons can also be used to increase or 
decrease the number of segments.

7. After your segment, or series of segments, has been 
defined, tap Enter on the screen The segment, or series of 
segments, then appears on the map.

8. Define the next segments as explained above, until all the 
segments have been entered (see example below).

Use this tool... to...

Select from plan

Show the whole plan

Zoom in on active point

Zoom out from active point

Zoom to select area

Set display options for labels (point names, etc.)
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Adding an Arc
to a Plan

1. Select Enter an Arc from the Tools menu located at the 
bottom of the Enter Line window.

2. Choose the start point (P1) and end point (P2) of the arc. 
These points can be selected from the plan, or from the 
list of points, after selecting the corresponding option 
through the nearby scroll-down arrow button. You can also 
key in manually their numbers (if known).
The selected points will then appear in red on the plan 
(see below).

3. Select which third parameter you will be using to let 
Layout Pro build the circle underlying the arc you want to 
create (this circle intersects the selected start and end 
points). This parameter can be:
– Radius: The radius (R) of the underlying circle (default 

option).
– Segment Height: The greatest perpendicular distance 

(H) from the chord (P1P2 segment) to the arc.
– Center Angle: The angle (α) formed by the start point 

(P1), the center point (C) of the underlying circle and 
the end point (P2).

– Diameter: The diameter (D=2R) of the underlying circle.

4. Enter the known value for the chosen parameter.
5. Choose whether you wish to define the arc as the short (A) 

or long (B) section of the underlying circle (choose Short 
or Long).

6. Tap Next. The arc appears in red on the plan.
7. Before entering the arc, you can still define the following: 

– Seg. Number: Number of segments of equal length you 
want to create along the arc (Default: 1). Creating two 
or more segments implies that the corresponding 
number of points will be created on the arc.

– Store Center Pt: Enable this option to store the center of 
the underlying circle. When enabled, a name is 
prompted for this point which you can keep or change.

P1

H

P2

B

A

C

R

α
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– Flip button: Tapping this button provides the other 
possible orientation for the arc. Tapping again this 
button will bring the arc back to its initial shape.

8. Tap Solve when you agree with the definition of the arc, 
which then appears on the plan. See example below.

Remember, you can always step back while creating an 
arc (or a line) using the Back button when shown. Once the 
arc (or line) has been created, it can be deleted by tapping 
Undo at the bottom of the screen.

Closure Check As you enter the last point from the blueprint, a dialog box 
appears and asks whether you want to add the point or 
connect it to an existing point. See example below.

To perform a closure check at any time, select Perform Closure 
Check from the Tools menu.
Use the zoom-in tool to see any error which can be caused by 
a “bust” in the blueprint dimensions or entering the 
dimensions incorrectly.
If a dialog box does not appear when you enter the last point 
on your blueprint, your plan does not close or you must select 
the Check for Overlapping Points function by selecting Options 
from the Tools menu.
6



Creating Grid Points

Additional points may be created on the plan by creating new 
lines based on existing points. The new points will result from 
the intersections of these new lines and possibly also with the 
other existing lines. 
1. Tap Plan on the main menu.
2. Tap Create Grid Points. Below is an example of what you can 

see on the screen.

3. Set the New lines intersect with existing lines option as 
follows:
– Check it on if you want to create points for every 

intersection.
– Clear it if you want to create points only at the 

intersections of the lines you specify.

4. Tap Next and define the new lines. For each new line, 
select the start point and end point directly on the plan. 
You are then prompted to name the line. The line and 
resulting new points appear in red on the plan.
Create as many lines as necessary. See example below.

5. When the plan shows all the points you would like to add, 
tap Store to save all of them.
7



Making Computations from your Entered Plan

1. Tap Plan on the main menu.
2. Tap Compute with Plan on the submenu.

3. Tap  in the lower-right corner of the screen. This opens 
up a menu from which you can perform various 
computations:

4. Select Compute Area to compute the area and perimeter of 
a group of points:

5. Select Compute Distance to compute the distance between 
two points:
8



6. Select Compute Angle to compute the angle between any 
three points:

7. Select Compute Down & Out to compute a point’s down and 
out distance from a line that you specify:

The blue line is the reference line. The red section that is 
overlaid on the blue line is the “down” portion. The red 
perpendicular line is the “out” portion.
9



Setting Up a Connected Total Station

Before using a total station to perform a stakeout or survey, 
you must set up your total station (in the location you want to 
shoot from), level it, and turn it on.
If you are using the onboard version of Layout Pro, nothing 
else needs to be done.
If you are running Layout Pro on a data collector, connect the 
data collector to the total station using a serial cable or 
Bluetooth.

Connection
Settings

To set the parameters on the Layout Pro software:
1. From the main menu, tap Settings.
2. From the Layout tab, enter the desired layout tolerance.
3. From the Instrument tab (the first tab), select the brand of 

the total station from the Brand list.
4. Set the parameters on the total station from the 

recommended settings.

Recommended
Settings for

Supported Total
Stations

Nikon 300 & 500 Series, Nivo M and DTM-322
(Tap the menu key on the total station, select Settings, and 
select Comm.)
• Ext. Comm (set to NIKON)
• Baud (4800 or match to Layout Pro)
• Length (set to 8)
• Parity (set to none or match Layout Pro)

• Stop Bit (set to 1)
10



Station Setup

If you choose to set up the total station over a marked point 
from the plan (Setup on a Known Point Location option, diagram 
[1] below), you will need to shoot one point.
If you choose to set up the total station at a random location 
(Setup at Any Location option, diagram [2] below), you will 
need to shoot two marked points from the plan for angle and 
distance measurements, or shoot three points if only angles 
are to be measured.
In both cases, you can decide to shoot more points for better 
control.

The two possible station setup procedures are described 
below.
1. Tap Instrument Setup from the Layout menu.
2. Choose how to set the instrument:

3. Tap Next.
4. Tell Layout Pro whether you want to measure elevation 

(Yes/No) then tap Next. If you are setting up on a known 
point and you want to measure elevation, first enter the 
instrument height, then tap Next.

PT1 PT1 PT2

[2][1]
11



5. If you chose Setup on a Known Point Location (see also 
diagram below):
• Select the point from the plan where to set up the 

instrument ([1]). Set up the instrument at this 
location.

• Select the reference point from the plan ([2]). Have a 
target placed over this point.

• Check that everything is ready for a shot ([3]), aim the 
instrument at the target and then tap Shoot.

• After Layout Pro has reported a valid measurement 
([4]), tap Finish. Station setup is now complete. 

[1] [2]

[3] [4]
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6. If you chose Setup at Any Location (see also diagram below):
• Set up the instrument at any convenient location from 

which you have a good view of the two reference points.
• Select the first reference point from the plan ([1]). 

Have a target placed over this point. Aim the 
instrument at this point and shoot it ([2])

• Repeat the first step for the second reference point 
used ([3] and [4]). You then get screen [5] on which 
the instrument position is reported to have been 
determined. Ensure that the calculated position of the 
instrument makes sense compared to the plan.

• Tap Finish to complete station setup. If you want to 
store the point where the instrument is located, first 
enable the Store Instrument Location option, tap Next, 
name the point and tap Finish.

NOTE: If elevation is measured, and because the 
instrument height cannot be entered in that case, be 
aware that the measured height will be that of the 
instrument itself, not that of the point on the ground. 
If you know exactly the height of the tripod used, and 
after storing the position of the instrument, you can 
edit its Z coordinate to make it a point on the ground. 

[1] [3]

[2] [4]

[5]
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Performing Stakeout

Stakeout Using an
Entered Plan

1. When everything is set up correctly (see Station Setup on 
page 11), tap Points from the Layout menu.

2. From the Layout Pro display, select the point you want to 
stake. The horizontal angle and horizontal distance to that 
point from the total station are displayed.

3. Tap Next. Layout Pro calculates and displays the value and 
direction of the angle –measured from the last shot– the 
instrument should be rotated by to be aligned with the 
stake point. 

4. Rotate the instrument in order to zero this angle. When 
done, you get the direction in which to find the stake 
point. (angle value shown in bold red on the screen, with 
right/left direction arrow; see example below).

5. Have the rod holder move to where you think the stake 
point should be. Aim your instrument at the rod holder 
and tap Shoot. The Layout Pro display shows the direction 
left or right and forward or back in the perspective of the 
total station operator.

(Green circle and black reticle: rod holder location; red 
circle and spot: stake point location)
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6. Guide the rod holder closer to the stake position and re-
shoot. You can re-shoot as many times as necessary until 
the rod is within an acceptable range of the correct 
position. Tap Stk> when an acceptable position is 
established.

7. Tap Store & Next Pt to store the position of the rod holder 
and to go back to the Define Stake Point screen from which 
you can select the next point you want to stake.

Stakeout Using a
Reference Line

1. When everything is set up correctly (see Station Setup on 
page 11), tap Line from the Layout menu.

2. Select two points for the reference line on the Layout Pro 
display.

3. Tap Next. Layout Pro calculates the distance between the 
two points you selected. The Flip button can be used to 
reverse the definition of the reference line (AB or BA)

4. Tap Next. You can choose between Stake Out Points and 
Show Position (see screen below).
15



• If you choose Stake Out Points and tap Next, a screen 
appears that explains the down and out method of 
measuring stake points (see screen below).

Key in the down and out positions for the point you 
want to stake.Tap Next.
Have the rod holder move to where you think the stake 
point should be. Aim your instrument at the person and 
tap Shoot. You can re-shoot as many times as necessary 
until the rod person is positioned correctly.

• If you choose Show Position, no entries are made. 
Simply take a shot at the rod and the position is shown 
in relation to the reference line. See example below.
16



Stakeout Using a
Reference Arc

1. When everything is set up correctly (see Station Setup on 
page 11), tap Arc from the Layout menu.

2. Define the reference arc or select an existing one from the 
plan, using one of the four options below.

• Two points on the arc & radius (see diagram [1]): Select 
the start (P1) and end (P1) points from the plan, key 
in the radius (R) and choose the short (A) or long (B) 
section.

• Three points on the arc (see diagram [2]): Select the start 
(P1), arc (P2) and end (P3) points from the plan.

• Center point & a point on the arc (see diagram [3]): Select 
the center point (P1) and arc point (P2) from the plan. 
This option defines a full circle. P2 is the start of the 
arc and the direction of the arc is clockwise.

• Select existing arc (see diagram [4]): Select an existing 
arc from the plan. Both the arc and the points defining 
the arc will be selected together.

Tap Next after making a choice and follow the instructions 
until the reference arc definition is complete (see example 
below).

P1

P2

B

A

c

R

P2

P1

P1

P3

P2

[1]

[2]

[3]

[4]
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3. Tap Next. You can choose between Stake Out Points and 
Show Position (see screen below).

• If you choose Stake Out Points and tap Next, a screen 
appears that explains the down and out method of 
measuring stake points (see screen below).

Shoot and adjust as required.
• If you choose Show Position, no entries are made. 

Simply take a shot at the rod and the position is shown 
in relation to the reference arc. See example below.
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Measuring Features

1. When everything is set up correctly (see Station Setup on 
page 11), tap Measure Features from the Layout menu. You 
may choose to measure either points or a line.

2. Enter a description (if desired) for the line or point being 
measured. Tap Shoot.

3. Repeat as necessary until all points have been measured.

Importing/Exporting Data

Tap Data Center on the main menu. From the submenu, you 
can:
• Import DXF jobs or points. Points will automatically be 

imported to a new job, not to the currently open job.
• Export jobs to DXF format, or points to customizable text 

format.
• Export layout data
• Export deviation data
• Generate Out-of-Tolerance reports.
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